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1. System configuration 

The system configuration of TOP and “GREENPOWER – STK CPS Master” is as follows: 

 

Series CPU 
Communication 

method 
System setting Cable 

GREENPOWER – STK CPS Converter RS–485 

3.1 Settings 

example 1 

(Page 4) 

4. Cable table 

Page 10 

 

■ Connection configuration 

 

ㆍ1:1 connection 
 

 

 

ㆍ1:N connection 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 
 

 

Settings Contents 

TOP Model Check the display and process of TOP to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select “GREENPOWER”. 
PLC Select an external device to connect to TOP. 

 

Model Interface Protocol 

STK CPS MASTER Serial WPS Link 
 

 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [Project > Project Property > TOP Setting] → [HMI Setup > “Use HMI Setup” Check > Edit > Serial] 

– Set the TOP communication interface in TOP Design Studio.  

 
 

 
 

Items TOP External device Remarks 

Signal Level (port) RS-485 RS-485  

Baud Rate 9600  

Data Bit 8  

Stop Bit 1  

Parity Bit none  

* The above settings are examples recommended by the company. 

 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device.  

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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(2) Communication option setting 

■ [Project > Project Property > Device Setting > COM > “PLC1 : STK CPS MASTER”] 

– Set the options of the STK CPS MASTER communication driver in TOP Design Studio. 
 

 

 

Items Settings Remarks 

Interface Select “Serial”. Refer to “2. External 

device selection”. Protocol Select “WPS Link”. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

Retry Configure the amount of request attempts from TOP to external device.   

Station No Prefix  

Rev Revised version  
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3.2. Communication setting in TOP  

* This is a setting method when "Use HMI Setup" in the setting items in "3.1 TOP Design Studio" is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

   

(1) Communication interface setting 

■ [Main Screen > Control Panel > Serial] 
 

 

Items TOP External device Remarks 

Signal Level (port) RS-485 RS-485  

Baud Rate 9600  

Data Bit 8  

Stop Bit 1  

Parity Bit none  

* The above settings are setting examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device.  

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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(2) Communication option setting 

■ [Main Screen > Control Panel > PLC] 
 

 

Items Settings Remarks 

Interface Select “Serial”. Refer to “2. External 

device selection”. Protocol Select “WPS Link”. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

Retry Configure the amount of request attempts from TOP to external device.   

Station No Prefix  

Rev Revised version  
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch "Communication diagnostics" in [Control Panel > PLC]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

5. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. External device setting 

 

Refer to the vendor’s user manual to identically configure the communication settings of the external device to that of the TOP. 
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5. Cable table 

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device. 

(The cable diagram described in this section may differ from the recommendations of “GREENPOWER – STK CPS MASTER”) 
 

■ RS-485 (1:1 connection) 

TOP 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Signal 

name 
 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA(+) 1  SDA(+)  

  SDB(-) 

  RDA(+) 

RDB(-) 4 RDB(-) 

SG 5 SG 

SDA(+) 6  

  

  

SDB(-) 9 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
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6. Supported addresses 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the 

address range supported by the device you want to use. 

 

Device Data R/W Size Description 

G00 ID R 16bit Unit category 

G01 Status R 16bit Unit status information 

0 : STOP 

1 : RUN 

2 : Fault 

3 : Warning 

4 : FailOver 

G02 Voltage R 16bit Rectified voltage 

G03 Voltage R 16bit Boost voltage 

G04 Current R 16bit Boost current 1 

G05 Current R 16bit Boost current 2 

G06 Current R 16bit Inverter output current 

G07 Current R 16bit Track current 

G08 Frequency R 16bit Output frequency 

G09 Temp R 16bit Converter heat sink temperature 

G10 Error code R 16bit Converter Error Code 

G11 Voltage RS R 16bit Input voltage RS 

G12 Voltage ST R 16bit Input voltage ST  

G13 Voltage TR R 16bit Input voltage TR 

G14 Current R R 16bit Input current R - 

G15 Current S R 16bit Input current S  

G16 Current T R 16bit Input current t - 

G17 Total kw R 16bit 3-phase Total Power 

G18 Kwh R 16bit Power 
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Converter Error list 

Error_Code  Error Name Description 
Converter LCD 

window 

1  Erec_peakVoltage  
 Input voltage greater than 420 V results in 

overvoltage 
 Erec P.V 

2  Erec_OverVoltage  
 Input voltage greater than 400 V results in 

overvoltage 
 Erec O.V 

3  Erec_UnderVoltage  
 Input voltage lesser than 230 V results in 

undervoltage 
 Erec U.V 

4  Eboost_PeakVoltage  
 DC voltage greater than 650 V results in 

overvoltage 
 Eboost P.V 

5  Eboost_OverVoltage  
 DC voltage greater than 680 V results in 

overvoltage 
 Eboost O.V 

6  Eboost_UnderVoltage   BOE B10 - Unused  Eboost U.V 
7  Ebuck_PeakVoltage   BOE B10 - Unused  Ebuck P.V 
8  Ebuck_OverVoltage   BOE B10 - Unused  Ebuck O.V 
9  Ebuck_UnderVoltage   BOE B10 - Unused  Ebuck U.V 

10  Iboost_PeakCurrent  
 Boost IGBT greater than 140 A results in 

overcurrent  
 Iboost P.C 

11  Iboost_OverCurrent  
 Boost IGBT greater than 150 A results in 

overcurrent  
 Iboost O.C 

12  Iboost2_PeakCurrent 
 Boost IGBT greater than 140 A results in 

overcurrent  
 Iboost2 P.C 

13  Iboost2_OverCurrent 
 Boost IGBT greater than 150 A results in 

overcurrent  
 Iboost2 O.C 

14  Ibuck_PeakCurrent   BOE B10 - Unused  Ibuck P.C 
15  Ibuck_OverCurrent   BOE B10 - Unused  Ibuck O.C 
16  Isrc_PeakCurrent   Track current greater than 180 A  Isrc P.C 
17  Isrc_OverCurrent   Track current greater than 170 A  Isrc O.C 
18  Isrc_UnderCurrent   Track current lesser than 100 A  Isrc U.C 
19  Isrc_FO_PeakCurrent   BOE B10 - Unused  F/O Isrc P.C.  
20  Isrc_FO_OverCurrent   BOE B10 - Unused  F/O Isrc O.C.  
21  Isrc_FO_UnderCurrent   BOE B10 - Unused  F/O Isrc U.C.  
22  Iout_PeakCurrent   Inv IGBT current greater than 180 A  Iout P.C 
23  Iout_OverCurrent   Inv IGBT current greater than 170 A  Iout O.C 
24  Boost1_Gate_Fault  Boost1 IGBT malfunction   BoostA GateFault  
25  Boost2_Gate_Fault  Boost2 IGBT malfunction   BoostB GateFault  

26  Buck_Gate_Fault   BOE B10 - Unused  Buck GateFault  

27  Inv1_Gate_Fault  Inverter1 IGBT malfunction  InvA GateFault  

28  Inv2_Gate_Fault  Inverter2 IGBT malfunction  InvB GateFault  

29  Initial_Charge_Fail   Failed initial charging during RUN operation   InitCharge Fail 

30  EMO_Stop_Int   Internal emergency operation for converter  EMO Stop Int  



 

 External device connection manual for TOP Design Studio 13 / 15 

Error_Code  Error Name Description 
Converter LCD 

window 

31  EMO_Stop_Ext   Internal emergency operation for converter   EMO Stop Ext 

32  Interlock_by_Ext   External interlock   Ext Interlock 

33  Fuse_Open   Input Fuse Open  Fuse Open 

34  Sag_Gen_Fault   Power outage lasts longer than 1 s  Sag Gen Fault 

35  Main_Fan_Fault   Faulty operation of main fan  Main Fan Fault 

36  HeatSink_OverHeat_80  Heat sink overheats to 80 °C (Bimetal)  HeatSink OverHeat  

37  IGBT_OverHeat   IGBT overheats to 80 °C (NTC)  IGBT OverHeat  

38  Track_Cable_OverHeat   Track Power Cable 90 °C thermal wire operation  OutCable OverHeat  

39  Inside_Cable_OverHeat  
 Converter’s Internal Power Cable 90 °C thermal 

wire operation 
 InCable OverHeat 

40  Busbar_OverHeat  Output busbar overheats to 80 °C (Bimetal)   Busbar OverTemp  

41  FO_Track_Cable_OverHeat BOE B10 - Unused  F/O OutCable O.T.  

42  FO_Inside_Cable_OverHeat BOE B10 - Unused  F/O InCable O.T.  

43  FO_Busbar_OverHeat  BOE B10 - Unused  F/O Busbar O.T. 

44  Panel_OverTemp_Fault  BOE B10 - Unused  Panel O.T Fault 

45  Smoke_Detect_Fault  BOE B10 - Unused  INT Smoke Fault  

46  Regulator Fault(Interlock)  Regulator Fault (Bypass break)   Regulator Fault 

47  eeprom_ad_check_sum_fail  Controller EEPROM Data Load error   Ad Data R/W Fail 

48  eeprom_sys_check_sum_fail  Controller EEPROM Data Load error   Sys Data R/W Fail 

49  eeprom_gain_check_sum_fail  Faulty controller EEPROM data load   GainData R/W Fail 

50  Watchdog_fault   Faulty controller operation   WatchDog Fault 

51  CANA_comm_Fail  BOE B10 - Unused  CANA Comm Fail 

52  CANB_comm_Fail  BOE B10 - Unused  CANB Comm Fail 

53  Master_Output_MC_Fail  BOE B10 - Unused  Master F/O MC Fail 

54  Slave_Output_MC_Fail  BOE B10 - Unused  Slave F/O MC Fail 

55  EXT_Input_Check_Fault  BOE B10 - Unused  EXT Input Fault 

56  AD_Connector_Open  BOE B10 - Unused  AD Connector OPEN 

57  est_Eboost_PV  BOE B10 - Unused  est Eboost PV 

58  est_Eboost_OV  BOE B10 - Unused  est Eboost OV 

59 Reserved Reserved Reserved 

60 Reserved Reserved Reserved 

61 Reserved Reserved Reserved 

62 Reserved Reserved Reserved 

63 Reserved Reserved Reserved 

64 Reserved Reserved Reserved 

65  FailOver_MC_Short  BOE B10 - Unused  Failover MC Short 

66  CPS2_Main_MC_Short BOE B10 - Unused  Failover MC Short 

67  CPS2_Sub_MC_Short BOE B10 - Unused  Failover MC Short 
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Error_Code  Error Name Description 
Converter LCD 

window 

68 Reserved Reserved Reserved 

69 Reserved Reserved Reserved 

70 Reserved Reserved Reserved 

71 Reserved Reserved Reserved 

72 Reserved Reserved Reserved 

73 Cap OverHeat Resonating capacitor overheats to 75 °C (Bimetal) Cap OverTemp 

74 Reserved Reserved Reserved 

75 Reserved Reserved Reserved 

76 Reserved Reserved Reserved 

77 Reserved Reserved Reserved 

78 Reserved Reserved Reserved 

79 Reserved Reserved Reserved 

80 Reserved Reserved Reserved 

81  HeatSink_OverHeat_60  Heat sink overheats to 60 °C (Bimetal)  HeatSink Warning 

82  Panel_OverTemp_Warning BOE B10 - Unused  Panel O.T Warning 

83  IGBT_OverHeat_Waning  IGBT overheats to 60 °C  IGBT O.T Warning 

84  Main_Fan_Warning  Main fan malfunction   Main Fan Warning 

85  Sub_FAN1_Warning  Side FAN1 malfunction   Side FAN1 Warning 

86  Sub_FAN2_Warning  Side FAN2 malfunction   Side FAN2 Warning 

87  Sub_FAN3_Warning  Side FAN3 malfunction   Side FAN3 Warning 

88  Sub_FAN4_Warning  Side FAN4 malfunction   Side FAN4 Warning 

89  Fail-Over BOE B10 - Unused  Fail-Over 

90 Reserved Reserved Reserved 

91 Reserved Reserved Reserved 

92 Reserved Reserved Reserved 

93 Reserved Reserved Reserved 

94 Reserved Reserved Reserved 

95 Reserved Reserved Reserved 

96 Reserved Reserved Reserved 

97  RS232_Comm_Fail  Failed communication with watt-hour meter   RS232 Comm Fail 

98  RS485_Comm_Fail  Master Panel Communication Fail  RS485 Comm Fail 

99  BlueTooth_Fail  BOE B10 - Unused  BlueTooth_Fail  

100 Reserved Reserved Reserved 

101 Reserved Reserved Reserved 

102 Reserved Reserved Reserved 

103 Reserved Reserved Reserved 

104 Reserved Reserved Reserved 

105 Reserved Reserved Reserved 
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Error_Code  Error Name Description 
Converter LCD 

window 

106 Reserved Reserved Reserved 

107 Reserved Reserved Reserved 

108 Reserved Reserved Reserved 

109 Reserved Reserved Reserved 

110 Reserved Reserved Reserved 

111 Reserved Reserved Reserved 

112 Reserved Reserved Reserved 

 


